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Visual Identity

Guidelines Introduction

These guidelines demonstrate the use of
design assets that relate to Special Olympics
Leadership seminars and events.

[é.

These guidelines do not demonstrate the use
of an identity for a team or a department.
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Guidelines Introduction

These guidelines explain how the Special
Olympics Leadership identity should be
implemented. Examples of the identity in action

supplied artwork files.
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The guidelines should be used in conjunction
with the Special Olympics Brand Identity
Guidelines to ensure we create consistent

are supplied along with guides on how to use the and engaging communications in line with the

Special Olympics Master Brand.
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Introduction

A New Understanding of Leadership

“Inclusion doesn’t just happen. From Division to Inclusion

People leading make it happen.”

— Frost and Aldina, Building an inclusive The world today is full of volatility, anger, fear of difference, and pressures
organisation, 2019 that divide people. Full inclusion offers hope — a way out of these divisions.

People with intellectual disabilities (ID), epitomized by the athletes of
Special Olympics, light the way by teaching others the true meaning of
inclusion. They inspire a world where everyone accesses the opportunities
in education, health, sport, work and social life that they deserve and want.
To build such a world, it is no longer enough to create accommodations for
people with disabilities; we need to tackle the unjust systems and attitudes
that create exclusion.

Special Olympics has for many years shown how to bring people, with and
without disabilities together to play, learn and live Unified. The time has
come to go even further, to ‘Lead Unified’, creating a new understanding of
inclusive leadership that helps build communities where everyone’s skills and
gifts are valued.

5 Leadership Identity Guidelines



Introduction

“People with intellectual
disabilities can absolutely
teach leadership skills
that help others. By simply
engaging with this, particularly
when they get training and
support to truly listen and
understand, other leaders
begin to see and be reminded
of things that matter most”

— Ben Haack, Special Olympics Athlete
Leader and Member of the Board of
Special Olympics International

Unified Leadership

The Unified Leadership Approach

Building from sport, Unified Leadership

teaches leaders of all abilities to value
and learn from each other, and inspires
change to create environments where
people with ID succeed in meaningful
jobs and roles.

Leadership Identity Guidelines

Why is Unified Leadership needed?
The leadership gifts and skills of
people with ID are underestimated
and undervalued. As a result, they
are often unable to achieve their
leadership potential because of the
attitudes and behaviors of other
leaders, and get few real opportunities
to show what they can do. For this

to change, training people with ID is
no longer enough, we also need to
educate the leaders around them.

How is Unified Leadership achieved?
Unified Leadership is not a standalone
program —it is delivered through
Special Olympics’ sports, health,
youth and leadership work. The
Unified Leadership approach involves
education and training of leaders
with and without disabilities, giving
them tools and skills that build
inclusive mindsets and behaviors.
Where possible, people with ID lead
the learning. Leaders are encouraged
to improve their own behaviors and
practices, and seek adaptations to

the ‘norm’, to reach a situation where
people with ID can successfully
contribute and perform joint or
independent jobs and roles.



Introduction

Ecosystem

How is Unified Leadership achieved?
Unified Leadership is an approach that

can be used by any leader, based on an
understanding that they have a crucial role
in facilitating an empowering environment
where people with ID thrive. Itis not a
standalone program —itis integrated into
Special Olympics’ sports, health, youth and
leadership work. The Unified Leadership
approach can also be adopted by any
organization that seeks to make the most
of the opportunities and performance § w
improvements that true diversity and
inclusion can bring.

asr " ’

ATHLETE

HEALTH
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Leadership Areas
UNIFIED ATHLETE HEALTH
LEADERSHIP LEADERSHIP LEADERSHIP
‘
SPORT , PROGRAM
LEADERSHIP "’ LEADERSHIP
YOUTH
0 LEADERSHIP
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Visual Identity BUilding BlOCks

Our visual identity is built on our

core building blocks. These central Special rﬂ.ﬁ;ﬁﬁ.‘
elements provide the framework Olympics §ﬁﬁa

for all visual communications.

Special Olympics Mark

SHAPING
MEANINGFUL
CHANGE

Background'Graphics Typography

PROGRAM
LEADERSHIP

Photography Area ldentifiers
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Visual Identity

It Takes Two

The core concept behind the identity is the idea
of two people coming together and focusing
on their relationship and interaction. This is
represented by two abstract shapes coming
together and highlighting the overlap between
the two shapes.
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Visual Identity It Ta kes Two

These shapes come together to create graphic
background elements that can be used across
all our communications.
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Visual Identity

Area Identifiers

UNIFIED
LEADERSHIP

HEALTH
LEADERSHIP

ATHLETE
LEADERSHIP

SPORT
LEADERSHIP

PROGRAM
LEADERSHIP

Arange of area identifiers have been
developed to represent the different
work areas within Special Olympics
Leadership. These can easily be used
on stationery items and presentations
(see 'ldentity in Action' section).

YOUTH
LEADERSHIP
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Visual Identity BaCkg rou nd Gra phics

The background graphics are available Unified Leadership Additional Colors
in a range of different colors. - -
Athlete Health Program Sport Youth
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Visual Identity Fo rma ts

The background graphics are available Web Banner Pull-up Banner
in a range of different formats.

Presentation Badge
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Visual Identity Prima ry Co lor Pa lEtte

Each work area has been assigned a Unified Leadership Athlete Leadership Health Leadership
specific set of colors from the Special
Olympics extended color palette.

Sport Leadership Youth Leadership Program Leadership
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Visual Identity

Primary Color Palette

Please use process color (CMYK) mix
created for artwork. Colors should
be visually matched to an up-to-date
Pantone® Swatch.

Unified Leadership Athlete Leadership Health Leadership Program Leadership Sport Leadership Youth Leadership

Light Red

Pantone® 186C

Process: 0C/100M/100Y/0K
RGB: 255R/0G/0B

HEX: #ED1C24

Mid Orange

Pantone® 1505C

Process: 0C/70M/100Y/5K
RGB: 230R/106G/31B
HEX: #E66ATF

Dark Orange
Pantone® 159C
Process: 0C/6

RGB: 152R/80G/6B
HEX: #985006

Mid Purple

Pantone® 267C

Process: 70C/100M/0Y/0K
RGB: 111R/44G/145B
HEX: #6F2C91

Dark Blue

Pantone® 294C

Process: 100C/80M/0Y/25K
RGB: 1R/59G/130B

HEX: #013B82

Mid Blue

Pantone® 300C

Process: 100C/50M/0Y/15K
RGB: 0R/99G/165B

HEX: #0063A5

Light Blue

Pantone® Process Blue
Process: 100C/20M/0Y/0K
RGB: 0R/149G/218B

HEX: #0095DA

Extra Li%ht Blue
Pantone™ —

Process: 65C/15M/0Y/0K
RGB: 80R/166G/211B
HEX: #50A6D3

Dark Turquoise
Pantone® 3302C

Process: 90C/0M/50Y/50K
RGB: 0R/105G/94B

HEX: #00695E

Mid Turquoise

Pantone® 3282C

Process: 80C/0M/50Y/20K
RGB: OR/ /132B

HEX: #009784

Light Turquoise
Pantone® 3262C
Process: 70C/0M/50Y/0K
RGB: 57R/187G/157B
HEX: #39BBSD

Extra Li%ht Turquoise
Pantone™ —

Process: 55C/0M/35Y/0K
RGB:111R/199G/1828B
HEX: #6FC7B6

Dark Orange

Pantone® 159C

Process: 0C/60M/100Y/45K
RGB: 152R/80G/6B

HEX: #985006

Mid Orange
Pantone® 1505C
Process: 0C/70M/100Y/5K

RGB: 230R/106G/31B
HEX: #E66ATF

Light Orange

Pantone® 137C

Process: 0C/50M/100Y/0K
RGB: 247R/148G/30B
HEX: #F7941E

Light Yellow

Pantone® 109C

Process: 0C/15M/100Y/0K
RGB: 255R/212G/0B

HEX: #FFD400

Dark Red

Pantone® 202C

Process: 0C/100M/100Y/55K
RGB: 130R/0G/0B

HEX: #820000

Mid Red

Pantone® 1945C

Process: 0C/100M/100Y/20K
RGB: 196R/22G/28B

HEX: #C4161C

Light Red

Pantone® 186C

Process: 0C/100M/100Y/0K
RGB: 255R/0G/0B

HEX: #ED1C24

Extra Light Red
Pantone® —

Process: 0C/90M/75Y/0K
RGB: 240R/65G/70B
HEX: #EF4347

Dark Purple

Pantone® 2695C

Process: 80C/100M/0Y/40K
RGB: 61R/16G/99B

HEX: #3D1063

Mid Purple

Pantone® 267C

Process: 70C/100M/0Y/0K
RGB: 111R/44G/145B
HEX: #6F2C91

Light Purple

Pantone® 2587C

Process: 50C/100M/0Y/0K
RGB: 146R/39G/143B
HEX: #92278F

Extra Light Purple
Pantone® —

Process: 45C/70M/0Y/0OK
RGB: 148R/99G/171B
HEX: #9463AB
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Visual Identity

Secondary Color Palette

A range of alternative color sets have been Variation 1 Variation 2 Variation 3

developed for general communications.

Light Red

Pantone® 186C

Process: 0C/100M/100Y/0K
RGB: 255R/0G/0B

HEX: #ED1C24

Light Orange

Pantone® 137C

Process: 0C/50M/100Y/0K
RGB: 247R/148G/30B
HEX: #F7941E

Mid Orange

Pantone™ 1505C
Process: 0C/70M/100Y/5K
RGB: 230R/106G/31B
HEX: #E66A1F

Mid Magenta

Pantone® 215C

Process: 0C/100M/20Y/20K
RGB: 196R/0G/99B

HEX: #C40063

Leadership Identity Guidelines

Light Mauve

Pantone® —

Process: 65C/60M/0Y/0K
RGB: 107R/107G/194B
HEX: #6B6BC2

Light Green

Pantone® 382C

Process: 35C/0M/100Y/0K
RGB: 178R/210G/53B
HEX: #B2D235

Light Turquoise
Pantone® 3262C
Process: 70C/0M/50Y/0K
RGB: 57R/187G/157B
HEX: #39BB9D

Dark Mauve

Pantone® —

Process: 89C/100M/25Y/23K
RGB: 61R/18G/99B

HEX: #3D1263

Light Green

Pantone® 382C

Process: 35C/0M/100Y/0K
RGB: 178R/210G/53B
HEX: #B2D235

Light Turquoise
Pantone® 3262C
Process: 70C/0M/50Y/0K
RGB: 57R/187G/157B
HEX: #39BB9D

Mid Blue

Pantone® 300C

Process: 100C/50M/0Y/15K
RGB: OR/99G/165B

HEX: #0063A5

Light Blue

Pantone® Process Blue
Process: 100C/20M/0Y/0K
RGB: OR/149G/218B

HEX: #0095DA




Visual Identity

Mark Positioning

Special Olympics Mark Landscape Portrait
We use our Special Olympics mark on all our
communications. The mark should always be

ATHLETEILEADERSHIP special Ty ATHLETE LEADERSHIP special AT T
positioned in the top right corner. owmpics Y37 Olympics g%a

Close-up

ATHLETE LEADERSHIP Special /IF'?N

Olympics §§|'ﬁ%'
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Visual Identity

Typography

GT WALSHEIM IS THE
TYPEFACE WE USE

FOR HEADINGS AND
STATEMENTS.

We pair GT Walsheim with Ubuntu, the
main Special Olympics typeface.
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Visual Identity

Typography

We use GT Walsheim Condensed Bold in 'all Landscape (Presentation Title Slide) Portrait (Pull-up Banner)
caps' for statements or headings across all our
communications.

ecial A
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INSPIRING . Ay
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CHANGE |, MEANINGFUL

CHANGE

Ubuntu is used for body copy and captions.
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Visual Identity

Typography

Strong Statements

NO GREAT
LEADER STANDS
ALONE

LEADERSHIP

IS ACTION NOT

POSITION INSPIRING AND

SHOWING THE
WAY FORWARD
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Visual Identity

Typography

Inspirational Phrases

SPORT LEADERSHIP Special flﬁﬁﬁ

ACHIEVING
POTENTIAL AN

OIlympics §ﬁ.ﬁ?

ADVOCATING
FOR BETTER
HEALTH

SHOWING
THE WAY
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Visual Identity Typog rap hy

Presentation Slides Publication Covers

INSPIRING
SHOWING MEANINGFUL

THE WAY CHANGE

ATHLETE LEADERSHIP

Ebitisti oremporem volupis esti

cullaborera aut harum facerat uscilis
sum aut laborest, omnihit, voluptur,
ut Fugitat usamet la volentotas
voluptaquate nonsequo quia dipitibus
exeribusci rem ipsaperchil mod

A [ ¢

N q
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Visual Identity

Illustrations in Action

Presentation Slide Pull-up Banner Web Banner

INSPIRING /~

INSPIRING . Ay MEANINGFUL

MEANINGFUL .. INSPIRING
MEANINGFUL

CHANGE

CHANGE CHANGE

Publication Cover

INSPIRING
MEANINGFUL
CHANGE

Area |dentifier

UNIFIED
LEADERSHIP

s

- 7/

. p
-
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Visual Identity

Photography

ATHLETE LEADERSHIP

Special ﬂ.le.ﬁﬁ
. . . Olympics Kﬁﬁ?
Alongside illustration, photography can .

be used across our communications.

LORETTA
CLAIBORNE

Lorem ipsum dolor sit amet, consectetur adipiscing
elit, sed do eiusmod tempor incididunt ut labore @&

Templates for image treatmentin
[llustrator format are available to
download on the Special Olympics
Leadership Dropbox Showcase.

Fora Step by Step tu torial on how to dolore magna aliqua. Ut enim ad minim veniam, quis
R nostrud exercitation ullamco laboris nisi ut aliquip
treat imagery, see page 28. ex ea commodo consequat.

Variation 1 Variation 2 Variation 3
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Visual Identity

Follow these steps to treat selected images:

Import image in Photoshop
Remove background
Convert to grayscale (Image > Mode > Grayscale)

P WwNR

Increase brightness and contrast in the
Adjustments panel

5. Flatten layers (select image layer and adjustment
layerin Layers panel, right click and select Flatten
Image)

6. Export as TIFF (File> Save as> TIFF)

7. Open'image treatment’ Illustrator file (available
to download on Dropbox Showcase)

8. Select existing image with direct selection tool

9. Replaceimage: Go to links panel and relink image
you want to replace

10. Adjust image placement with direct selection tool
accordingly

11. Export file (File > Export > Export as > PNG > Select
artboard > Export)

y -
Direct Selection Tool [4)

"3

Image Treatment

——rp e e

B8 Facie Stace At

Releazs from lsal

Flatten
[3] b0 Color

| ]

Characicd

Myriad Pro

Save As

Save As: [Lurcllal:lalhurnc_ﬂw.ﬁd

Tags:
Wihare: Links
Format: TIFF
Save: As a Copy
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Visual Identity

Arange of statements have been

developed for the different Leadership

work areas.

Messaging

Unified Leadership

INSPIRING
MEANINGFUL
CHANGE

Leadership Identity Guidelines

Sport Leadership

ACHIEVING
POTENTIAL

Youth Leadership

BUILDING
THE FUTURE

Health Leadership

ADVOCATING
FOR BETTER
HEALTH

Athlete Leadership

SHOWING
THE WAY

Program Leadership

INCLUDING
BY EXAMPLE
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Identity in Action

Presentation Slides

Presentation Title Slides

Unified Leadership Athlete Leadership Sport Leadership Program Leadership

Ea

INCLUD
BY EXA

iar AT
v Oigmpice ng

INSPIRING
MEANINGFUL .. ~ ;

SHOWING ACHIEVING
THE WAY POTENTIAL NG

CHANGE

Health Leadership Youth Leadership

ADVOCATING BUILDING
FOR BETTER THEFUTURE ¢ -°

HEALTH
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Identity in Action Presenta tion Slides

Internal Presentation Slides

Unified Leadership Athlete Leadership Sport Leadership Program Leadership
- SHOWING ACHIEVING INCLUDING
NI THE WAY POTENTIAL BY EXAMPLE
A NI
i y

Health Leadership Youth Leadership

ADVOCATING BUILDING

FOR BETTER THE FUTURE
HEALTH
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Identity in Action Presenta tion Slides

Work areas — Overview

Work Areas

Te®

ATHLETE SPORT PROGRAM YOUTH HEALTH

Lorem ipsum dolor sit amet , consectetuer adipiscing
elit, sed diam nonummy nibh euismod tincidunt ut
laoreet dolore magna aliquam erat v olutpat. Ut wisi
enim ad minim veniam, quis nostrud ex erci tation
ullamcorper suscipit lobortis nisl ut aliquip ex ea
commodo consequat .
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Identity in Action

Documents

Area |dentifier— Placement on documents

ATHLETE special AT
LEADERSHIP Olympics Eﬁﬁ’

d Leadership Program

Loremipsum tuer adipiscing elit, sed diam nonumm

nibh euismod tincidunt ut laoreet dolore magna aliquam erat volutpat. Ut

wisi enim ad minim veniam, quis nostrud exerci tation ullamcorper suscipit

Iobortis nislut aliquip ex ea commado consequat. Duis auter

iriure dolor in hendreritin vulputate velit

illum dolore eu feugiat nulla acilisis a msan etiusto odio
ignissim qui blandit praesent luptatum zzril delenit augue duis dolore te
ugait nulla Facils,

Lorem ipsum dolor sit amet, cons ectetuer adipiscing elt, sed diam
nonummy nibh evismod tincidunt ut aoreet dolore magna aliquam era
utpat. Ut wisi enim ad minim veniam, quis nostrud exerci tation ullamcorper
suscipitlobortis nis ut aliquip ex ea commodo consequat. Lorem ipsum dolor
sitamet, consectetuer adipiscing elt, sed diam nonummi
tincidunt ut laoreet dolore magna aliquam era

minim veniam, quis nostrud exerci tation

PROGRAM
LEADERSHIP

Unified Leadership Program

r adipi t,sed diam nonummy
nibh euismod tincidunt ut laoreet dolore magna aliquam erat volutpat. Ut
wisi enim ad minim veniam, quis nostrud exercitation ullamcorper suscipit
obortis nisl ut aliquip ex e2 commodo consequat. Duis autem vel eum
iriure dolor in hendr
illum dolore eu Feugiat nulla Facilss at vero eros et accumsan et iusto odio
dignissim qui blandit praesent luptatum zzrildelenit augue duis
it nulla acilis
Lorem ipsum dolor s geli
nonummy nibh evismod tincidunt ut laoreet dolore magna aliqua
lutpat. Ut wisi enim ad minim veniam, quis nostrud exerc tation ullamcorper
i ut aliquip ex ea commodo consequat. Lorem ipsum dolor
ummy nibh euismod
magna aliquam erat volutpat. Ut wisi enim ad
minim veniam, quis nostrud exerci tatio

SPORT a0,
LEADERSHIP oigmics $i7

dipiscing elit umm

oreet dolore magna aliquam erat volutpat. Ut

wisi enim ad minim veniam, quis nostrud exerci tation ullamcorper suscipit.
lobortis nisl ut aliquip ex ea commodo consequat. Duis autem vel eum
in hendrerit in vulputate velit s stie consequat, vel

illum dolore eu Feugiat nulla Facilsis at vero eros et accumsan et iusto odio

dignissim qui blandit praesent luptatum zzril delenit augue duis dolore te

feugait nulla facilisi

orem ipsum dolor sit amet, c
nonummy nibh euismod tincidunt ut laoreet dolore magna aliquam era

lutpat. Ut wisi enim ad minim veniam, quis nostrud exerci tation ullamcorper

suscipit lobortis nisl ut aliquip ex ea commodo consequat. Lorem ipsum dolor

tuer adipiscing elt,

sitamel
tincidunt ut laoreet dolore magna aliqu:

minim veniam, quis n citation

YOUTH special I
LEADERSHIP olgmpics

Unified Leadership Program

Lorem ipsum dolor sit ame diam nonummy
nibh evismod tincidunt ut laoreet dolore magna aliquam erat v
wisi enim ad minim veniam, quis nostrud exerci tation ullam;
lobortis nisl ut aliquip ex ea commodo consequat. Duis autem vel eum
iriure dolor in hendreritin vulputate veli |
illum dolore eu Feugiat nulla facilis
dignissim qui blandit praesent luptatum
feugait nulla faci

Lorem ipsum dolor sit e
nonummy nibh euismod tincidunt ut laoreet dolore magna aliquam erat
lutpat. Ut wisi enim ad minim veniam, quis nostrud exerci tation ullamcorper
suscipit lob Lut aliqui onsequat. Lorem ipsum
sit amet, consectetuer adipiscing elit, sed diam nonummy nibh euismod
tincidunt ut laoreet dolore magna aliquam erat volutpat. Ut wisi enim ad
minim veniam, quis nostrud exerci tation

HEALTH 250
LEADERSHIP Oigicn e

Unified Leadership Program

nibh euismod tincidunt ut laoreet dolore magna aliquam et

rud exerc tal

quat, vel
illum dolore eu feugiat nulla facil 70 eros et accumsan et usto odio
dignissim aui blandit praesent luptatum zzril delenit augue duis
feugait nulla facilisi
0 , ing elt, sed diam
nonummy oreet dolore magna aliquam erat
lutpat. Ut wisi enim ad minim veniam, quis nostrud exerci tation ullamcorper
it lobortis nisl ut aliquip ex uat. Lorem ipsum d
tetuer adipiscing elit, sed diam nonummy nibh evismod
tincidunt ut laoreet dolore magna aliquam erat volutpat. Ut wisi enim ad
minim veniam, quis nostrud exerci tation

Athlete Leadership Program Leadership Sport Leadership Youth Leadership Health Leadership
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BUILDING
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BUILDI
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INCLUDE

REGION
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Identity in Action

Pull-up Banners

Pull-up banners for events

special AT special AT

Olympics Fﬁ'ﬁ% Olympics Fgﬁé%

special AT special AT special AT

Olympics %gﬁea Olympics Kﬁ'ﬁ? Olympics Eﬁ"e?

ACHIEVING J BUILDING

INSPIRING SHOWING [ ADVOCATING
POTENTIAL J THE FUTURE

MEANINGFUL FOR BETTER
THE WAY HEALTH

CHANGE

Unified Leadership Athlete Leadership Health Leadership Program Leadership Sport Leadership Youth Leadership
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Identity in Action we bSite

Website banner

A ) .
Kﬁ.ﬁ? Special Olympics  OuR WORK GETIN VOLVED STORIES Q DON ATE

INSPIRING
MEANINGFUL ' |
CHANGE ‘

P pecial Olympics
¢ unified Leadershi

Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed
diam nonummy nibh euismod tincidunt ut laoreet dolore
magna aliquam erat volutpat. Ut wisi enim ad minim veniam,
quis nostrud exerci tation ullamcorper suscipit lobortis nisl ut
aliquip ex ea commodo consequat.
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Identity in Action

Badges

SPORT PR AM
LEADER LEADER

Special AN Speci: gﬁﬁﬁ

" |
Olympics Eﬁ.ﬁa Olympics

UNIFIED ATHLETE
LEADER LEADER

jan, T ian T
m;s;’:rne;;":s’ Fﬁ‘ﬁ? UIZ’:’:::’S' ‘5%"@'

HEALTH
LEADER

YOUTH
LEADER

Special ‘ﬂ‘F ﬁﬁ-

Special .”I.F ﬁ.ﬁ‘\ |
Olympics ﬁﬁ'ﬁa

Olympics Kﬁ.ﬁa
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Identity in Action

Publication Covers

INSPIRING
MEANINGFUL
CHANGE INSPIRING
MEANINGFUL

CHANGE

a’5pec_ial 'é;.;.;-,
lympics

i ﬂ'fé ﬁl\
e (02
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Management Contact & Resou rces

Every single participant in the Special Olympics Movement can play a role in
aligning and strengthening our brand around the world. These guidelines as
well as a comprehensive suite of tools, messaging materials and templates are
available for all to download from shorturl.at/juHIY

We encourage you to contact nafiouni@specialolympics.org with any
questions, queries or comments you may have at any stage.

40 Leadership Identity Guidelines






